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4

1 Explanation of symbols

1.1 Abbreviations

This symbol warns the user of possible danger. Not following this warning can 
lead to personal injury or death and/or destruction of the equipment.

Pay attention to passages marked with this symbol. Failure to observe the 
provided instructions could lead to personal injury or damage to equipment.

This symbol draws the user's attention to important information.

AS-i AS-interface (actuator sensor interface) 

ACT AS-i Control Tools

LDS List of Detected Slaves

LAS List of Activated Slaves

LPS List of Projected Slaves

LCS List of Corrupted Slaves 
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2 Features

AS-i Control Tools is a Windows software for the comfortable commissioning of the 
AS-interface and the programming of AS-i Control with Instruction List (STEP 5®). 
The following features apply to AS-i Control Tools from Version 4.6.7:

General Information
• Now with full support of all features of the AS-i specification 3.0
• full downward compatibility to Pepperl+Fuchs Master of AS-i specification 2.0 

and 2.1
• full support of AS-i Safety at Work
• operating system: Windows 2000, Windows XP, Windows NT4 and Windows 

Vista
• comprehensible operator guidance
• simple installation
• languages: English/German
• extensive help menu

AS-i Configuration Editor
• tool for putting AS-i into operation
• display of the actual configuration on the AS-interface (slave profiles in plain 

text)
• AS-i circuit can be displayed grafically with icons for AS-i Master and AS-i slaves

Complete diagnostics of AS-i circuit
• comparison of actual configuration with the projected configuration
• programming of slave addresses
• projecting of the actual configuration
• reading of inputs (digital and analogue)
• writing of outputs (digital and analogue)
• writing of parameters
• projecting of individual slaves
• reading and writing of strings, if slaves provide the corresponding functions

AS-i Instruction List Editor (IL)
• editor for the generation of AS-i Control programs as Instruction Lists (orientat-

ed to STEP 5®)
• download Instruction Lists
• AS-i Control program Syntax Check
• AS-i Control program start/stop
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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AS-i Instruction List Debugger, AS-i Instruction List Simulator
• graphic representation of inputs and outputs, timers, counters and flags. Addi-

tionally, process data can be overwritten by the user.
• testing tool for the AS-i Control program with a projected AS-i circuit (debugger)
• testing tool for the AS-i Control program without there actually being an AS-i cir-

cuit (simulator)

Complete diagnostics of AS-i Safety at Work circuit 
• diagnostics of code sequences
• diagnostics of Safety Monitor 
• status of Safety-Slaves
• status of release circuit

Other Functions
• AS-i Address Assistant
• advanced AS-i Diagnosis
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany

Pepperl+Fuchs Group · Tel.: Germany (6 21) 7 76-0 · USA (3 30) 4 25 35 55 · Singapore 7 79 90 91 · Internet http://www.pepperl-fuchs.com6



   

AS-Interface Control Tools
First Steps
Is
su

e 
da

te
 - 

28
.7

.2
00

8

3 First Steps

System Requirements
Installation of the Software ACT
Removing of previous versions of ACT
Registration of the software
Help
Building up the Communication with an AS-i Master
Putting AS-i into Operation
Working with AS-i Configuration files (*.acg)

3.1 System Requirements

For proper operation of AS-i Control Tools (from now on called "ACT" in this doc-
ument) your system should meet at least the following requirements:
• Windows 2000, XP, NT4 or Vista
• PC with Pentium III processor or higher
• CD-ROM or DVD drive
• hard disk drive with 512 MB RAM and about 20 GB free space

3.2 Installation of the ACT Software 

For the installation of the ACT software Windows must run on your computer. Put 
the installation disk into the CD-ROM or DVD drive and start the installation pro-
gram setup.exe with the command Execute. The installation program leads you 
through all necessary inquiries and creates a new Windows program group, if de-
sired.
If you use certain PC cards (AS-Interface PC2 Card bzw. AS-Imterface PC/104 
Card) it may be possible that you have to confirm the activation of the drivers for 
this cards separately while installing ACT.
If there is an older version of ACT on your PC, you have to uninstall it before in-
stalling the new version. Alternatively you can install the new version into another 
directory. Please save the Registration Numbers before uninstalling the older ver-
sion of ACT to reuse them later if necessary.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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3.3 Removing of the ACT software

The removing of AS-i Control Tools is very simple and comfortable. Just open the 
devicemanager of your Windows operating system and activate the deinstallation 
program for ACT in the system control program.

3.4 Registration of the Software

After installing the software you should enter your registration codes. Use the com-
mand Registration in the Help menu.

The input of the corresponding codes allows the licensing of the basis software 
as well as the enabling of AS-i Control functions for programmes larger than 
600 Bytes and the use of extended AS-i diagnostics and interface functions.
If your software CD does not include the registration codes, please contact the 
software producer to ask for the adequate codes.
Please save the Registration Numbers after installing ACT to reuse them later if 
necessary. If they get lost the codes have to be purchasede again.
After inserting the codes the software can be used with the extended functions. 

The deinstallation program for ACT removes the device list (file dev-
list.txt) which is created by the grafical AS-i Configuration editor. If 
you want to re-use this device list in the new version of ACT, you 
have to save the the file devlist.txt before deinstalling the old ver-
sion. After installing the new version, copy the file into new program 
directory (this will overwrite the installed original file).
AS-i Configuration files (*.acg) won't be removed by the deinstalla-
tion program.

Without registration codes the diagnostics and interface functions 
and the extent of the AS-i Instruction Lists are available only with 
limited funtionality. But the functions that can be used have complete 
operability. If you do not registrate your copy of ACT during the 
installation the program reminds you at regular intervals.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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3.5 Help

If you need help to a certain topic choose one of the help commands in the Help 
menu or use the context help.

(see toolbar )

3.6 Building up the Communication with an AS-i Master

After the first start of AS-i Control Tools the software is in the offline mode. In the 
Master menu the entry offline is checked. In addition to that the title bar of the win-
dow AS-i Configuration shows the type of the AS-i Master and other communi-
cation parameters. While the software in in the offline mode, the title bar entry is 
Offline.

Building up the communication with a new AS-i Master
1. Connect an AS-i Master to your PC (connection to a serial interface, a Fildbus-

interface or installation of an AS-i PC board).
2. Choose the command New in the Master menu.
3. Choose the protocol (Standard, Modbus, Profibus and so on).
4. Choose also the other communication parameters (e.g. serial interface or I/O-

port etc., depending on the protocol).
Confirm with OK.

AS-i Control Tools now builds up the connection to the selected AS-i Master.

3.7 Putting AS-i into Operation

If you want to put AS-i into operation, start the AS-i configuration editor with com-
mand AS-i Configuration in the Master menu. More informationen to the AS-i 
configuration editor can be found in the chapter Master Menu (see page 28).

3.8 Working With AS-i Configuration Files (*.acg)

Saving and Loading an AS-i Configuration
An AS-i configuration can be stored to an AS-i configuration file with the command 
Save Configuration to File in the Master menu. This way you can create an AS-i 
configuration offline and load and write it to the AS-i master later on with the com-
mand Write Configuration to the AS-i Master.

All changes of the AS-i data made with ACT are now carried out directly 
by the connected AS-i Master!
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Copying an AS-i Configuration
If there are one or more equal or similar AS-i circuits in the plant, you can save the 
AS-i configuration to different files with the command Save Configuration to File.

Documentation of the Plant
The AS-i configuration files are readable text files with the suffix .acg. They can be 
opened with the command Open in the File menu and printed for documentation 
purposes.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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4 AS-i Control Programs

AS-i Control programs are control programs that are processed in the AS-i Master. 
To execute certain functions the AS-i Master may have to be activated (see page 
59). They are written in a syntax similar to STEP 5® (or in 8051-assembler).  These 
AS-i Control programs written in instruction list or assembler have the file suffix 
*.asi.
With AS-i Control Tools you can execute, debug or simulate AS-i Control pro-
grams.
After the start the software is in execute mode. You can start the AS-i Control pro-
gram stored in the AS-i Master (if there is a programm in the AS-i Master), stop it 
or upload it into a new editor window.
Changing to debug or simulation mode is only possible if there is an AS-i Control 
program in an editor window (use the command Open AS-Interface Control 
Mainfile... in the File menu). Change to another mode of operation by using the 
commands of the Program Control menu.
You can watch and partly change the AS-i process data with various monitor win-
dows (see Window menu).

4.1 Creating an AS-i Control Program

New or existing AS-i Control programs can be edited in the Open AS-Interface 
Control Mainfile... editor window (File window). With the Ins key you can toggle 
between insert and overwrite mode.The Edit menu gives you an overview of the 
edit commands.
The syntax of this type of programs is described in the manual AS-i Control. Ex-
amples you can also find in the file folder ...\Samples\English in the directory of 
AS-i Control Tools.

4.2 AS-i Control Demo-Programs

There are several samples of AS-i Control programs in the subdirectory AS-Inter-
face Control Tools\Samples\English or ...\Deutsch. You can use these demo-

AS-i Control programs can be written in English or German syntax. 
Compiling an AS-i Control program with German syntax with the 
English version of AS-i Control Tools will cause syntax errors.The 
language of the syntax of the AS-Interface Control Mainfile can be 
defined for safety reasons: [program:de] or [program:en]

The file format of instruction list documents is plain ASCII. Therefore 
you can use the editor of your choice (or any word-processing pro-
gram with ASCII import/export feature) to create or modify an AS-i 
Control program. Simply load it into the application with the Open 
AS-Interface Control Mainfile... command from the File menu 
afterwards.
German umlaut and additional caharcters may cause problems of 
displaying because of the different symbol set of DOS and Windows 
and should be used only for comments.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany

Pepperl+Fuchs Group · Tel.: Germany (6 21) 7 76-0 · USA (3 30) 4 25 35 55 · Singapore 7 79 90 91 · Internet http://www.pepperl-fuchs.com 11



  

AS-Interface
AS-i Control Programs
Is
su

e 
da

te
 - 

28
.7

.2
00

8

programs to familiarize yourself with AS-i and the programming language. Further 
information can be obtained from the manual AS-i Control.

4.3 The First AS-i Control Program

Among others we have prepared the demo-file First.asi for you. It requires two 
AS-i Slaves with the profile 2I/2O (2 inputs / 2 outputs). This demo-program reads 
two inputs of two AS-i slaves and produces the result on the outputs of these AS-i 
slaves.

We’d like to invite you to go through this demo now to find out about the possibili-
ties of different modes of operation (Execute, Debug and Simulate).

What shall I do?/What happens? How do I have to proceed?

Please open the file First.asi in the 
directory ...\Samples\English.

Click File, then Open AS-Interface 
Control Mainfile. Double-click the 
directory ...\Samples\English and 
select the file First.asi from the file list 
by clicking on it. Press OK.

Now a document window which con-
tains First.asi appears in the applica-
tion window.
Change to Simulate mode. Click Progam Control, then Simulate.
AS-i Control Tools checks the syntax 
and consistence of the program and 
compiles the program.

Press OK.

Open the input monitor and the output 
monitor.

Click Window, then Input Monitor. 
Again click Window, then Output 
Monitor.

Now the input and output monitors 
appear overlapping in the application 
window.
Arrange the windows next to each 
other.

Click Window, then Tile.

Start the simulation. Click Program Control, then Start
The simulation is running now.
Set input 3 of slave 1 (E1.3). Click right on the respective slash in 

the input monitor.
Instead of the dot an X appears in the 
input monitor to indicate that the bit is 
set now. After that the simulation of 
First.asi sets output 1 of slave 1. This 
is displayed as an X at the respective 
spot in the output monitor.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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In the next step we want to build up and debug the AS-i circuit which we have only 
simulated so far.

In the last step we want to load the AS-i Control program into the AS-i Master and 
start and control it with AS-i Control Tools.

You can do the same thing now for the other programmed inputs E1.2, E2.2 and 
E2.3, too. Of course you can also reset the inputs again simply by clicking the 
respective dot. The control program then resets the corresponding output.
Stop the control program. Click Program Control, then Stop

What shall I do?/What happens? How do I have to proceed?

Connect an AS-i Master to your PC.
Set the options for the communication 
between PC and AS-i Master.

Building up the Communication with an 
AS-i Master (Master...New..., see 
page 25)

Switch to Debug mode. Click Program Control, then Debug.
For that purpose the instruction list 
First.asi has to be active. If not, acti-
vate the window with the file First.asi.

Click the window First.asi or click 
Window, then the menu item First.asi.

AS-i Control Tools checks the syntax 
and consistence of the program and 
compiles the program.

Press OK.

Start the program. Click Program Control, then Start
Now you can manipulate the inputs of your connected slaves. As a result the 
corresponding outputs will switch. The inputs and outputs are displayed in the 
monitor windows for control of their respective states.The user can also switch 
the inputs and outputs in the monitor windows. As soon as you change the 
states of a slave in this manner, it is displayed by an X in the row User. Now the 
inputs or outputs of these slaves can not be changed by the control program 
anymore, until you cancel this modification by clicking the corresponding X in 
the User-row.
Stop the Control program. Click Program Control, then Stop

What shall I do?/What happens? How do I have to proceed?

Switch to Execute mode. Click Program Control, then Exe-
cute.

Load the control program First.asi to 
the AS-i Master.

Click Program Control, then Write 
AS-Interface Control Mainfile to the 
AS-Interface Master...

For that purpose the instruction list 
First.asi has to be active. If not, acti-
vate the window with the file First.asi.

Click the window First.asi or click 
Window, then the menu item First.asi.

What shall I do?/What happens? How do I have to proceed?
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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AS-i Control Tools checks the syntax 
and consistence of the program and 
compiles the program. The program is 
loaded into the AS-i Master.

Click OK.

Start the program. Click Program Control, then Start
As soon as the program is started you can manipulate the inputs of the slaves, 
after which the corresponding outputs will switch. Inputs and outputs can be 
supervised in the monitor windows. However, changing inputs or outputs is not 
possible in the execute mode.

As soon as the program is started you can manipulate the inputs of 
the slaves, after which the corresponding outputs will switch. Inputs 
and outputs can be supervised in the monitor windows. However, 
changing inputs or outputs is not possible in the Execute mode.

What shall I do?/What happens? How do I have to proceed?
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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5 File... Menu

5.1 File... New [Ctrl+N]

Use this command to create a new text file. Specify the type of file you want to cre-
ate:

Instruction list (*.asi)
Files with the suffix asi, are AS-i Control programs.

AS-i Configuration (*.acg)
These files are generated by the command Save Configuration to File... in the 
Master menu. Generating this type of file by the command New is possible but is 
not normally meaningful.

5.2 File... Open... [Ctrl+O]

Use this command to open an existing document in a new window.
The following options allow you to specify which file to open:

File Name
Type or select the name of the file you want to open. This box lists files with the 
extension you selected in the List Files of Type box.

List Files of Type
Select the type of file you want to open:
• AS-i Control programs (Instruction list files) (*.asi)
• AS-i Configuration (*.acg)

Drives
Select the drive in which the file you want to open is stored.

Directories
Select the directory in which the file you want to open is stored.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Network
Choose this button to connect to a network location, assigning it a new drive letter.

You can open several documents at once. You can easily open one of the last four 
closed files with the File 1, 2, 3, 4 command.
Use the Window menu to switch between open documents (Menu Window co-
mand 1,2,..., see page 57).
You can create new documents with the New command.

5.3 File... Close

Use this command to close all windows containing the active document. Before 
you close the document you are asked to save the changes. If you close a docu-
ment without saving, you lose all changes made since the last time you saved it.
Before closing an untitled document, the Save As dialog is displayed and prompts 
you to name and save the document.

5.4 File... Save [Ctrl+S]

Use this command to save the active document under its current name and direc-
tory.
When you save a document for the first time, the Save As dialog is displayed so 
you can name your document. If you want to change the name and directory of an 
existing document before you save it, also choose the Save As command.

5.5 File... Save As...

Use this command to save and (re)name the active document. The Save As dialog 
is displayed so you can name your document.
The following options allow you to specify the name and location of the file you are 
about to save:

File Name
Type a new file name to save a document under a different name. Note the possi-
bly restrictions of your operating system when you type in the file name. The file 
extension you specified in the Save File As Type box is automatically added.

Drives
Select the drive where you want to save the document.

Directories
Select the directory in which you want to save the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 
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To save a document under its existing name and directory, use the Save com-
mand.

5.6 File... Open AS-Interface Control Mainfile...

Use this command to open an existing instruction list document (*.asi) in a new 
window as the mainfile of an AS-i Control program.
As soon as you have opened an AS-i Control mainfile the items Debug, Simulate, 
Write AS-Interface Control Mainfile to the AS-Interface Master..., Syntax 
Check and Compile in the menu Program Control are available. All these items 
in the menu Program Control refer to the AS-i Control mainfile.
The items in teh dialogbox are the same as with the command File... Open and 
are described there.

5.7 File... Print... [Ctrl+D]

Use this command to print a document. In the Pop-Up window that opens you can 
select the printer that you want to use. You can also define the pressure range, the 
amount of copies and other settings concerning the printer. 

5.8 File... Print Preview...

Use this command to display the active document as it will appear when printed. 
When you choose this command, the main window is replaced with a print preview 
window in which one or two pages are displayed in their printed format. The Print 
preview toolbar offers you the following options:

Print
Brings up the Print dialog to start a print job.

Next Page
Preview the next page.

Prev Page
Preview the previous page.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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One Page/Two Page
Preview one or two pages at a time.

Zoom In
Take a closer look at the page.

Zoom Out
View the page to be printed from further away.

Close
Return from print preview to the editing window.

5.9 File... Print Setup...

Use this command to select a printer and a printer connection. This command pre-
sents the Print Setup dialog, where you specify the printer and its settings. Here 
you can select the printer that you want to use. You can also define the paper size, 
the printing format (portrait or landscape format) and other settings concerning the 
printer.

5.10 File... 1, 2, 3, 4

Use the numbers and file names listed at the bottom of the File menu to open one 
of the last four documents you closed. Choose the number that corresponds with 
the document you want to open or click with the mouse on its name.
You can also use the New or Open command to create a document window.

5.11 File... Exit

Use this command to end your working session.
The application prompts you to save documents with unsaved changes.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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6 Edit... Menu

6.1 Edit... Undo [Ctrl+Z]

Use this command to reverse the last editing action.

6.2 Edit... Cut [Ctrl+X]

Use this command to remove the currently selected data from the document and 
put it in the clipboard. This command is only available if you have made a selec-
tion.
Cutting data to the clipboard replaces the contents stored there previously.

6.3 Edit... Copy [Ctrl+C]

Use this command to copy selected data into the clipboard. This command is only 
available if you have made a selection.
Copying data to the clipboard replaces the contents stored there previously.

6.4 Edit... Paste [Ctrl+Y]

Use this command to insert a copy of the clipboard contents at the insertion point. 
This command is unavailable if the clipboard is empty.

6.5 Edit... Delete [Del]

Use this command to delete the currently selected data. This command is only 
available if you have made a selection.

The Edit menu only appears when a file is open whicht can be edited 
by ACT.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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6.6 Edit... Select All [Ctrl+A]

Use this command to select the entire document contents for further edit opera-
tions.

6.7 Edit... Find... [Alt+F3]

Use this command to find specific text within the document.
In the Find dialog you can specify the text, you want to search for and options for 
how to search:

Search for
Type in the text to search for.

Match Case checkbox
If you mark this checkbox, the string of the text field will only be found in case that 
the characters match exactly.

Direction
Specifies the direction (up or down) in which the document has to be searched for 
the string.

Find Next
Use this button to continue the search and to mark the next occurrence of the 
specified string.

You may repeat your last search with the Find next command.

6.8 Edit... Find Next [F3]

Use this command to repeat the last search initiated with the Find command.

6.9 Edit... Replace...

Use this command to find specific text within the active document and replace it 
with different text.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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The Replace dialog lets you specify the texts you want to search for and to replace 
with and some options:

Search text
Type in the text to search for.

Replace text
Type in the text to replace with. If you want to erase the Search text, don't fill in 
any text here.

Match Case checkbox
If you mark this checkbox, the string of the text field will only be found in case that 
the characters match exactly.

Find
Use this button to continue the search and to mark the next occurrence of the 
specified string.

Replace
Use this button to replace the text string found with the Replace string. After that, 
the next occurence of the search string will be searched for.

Replace All
Use this button to find all occurences of the Search string and replace them with 
the Replace string without user interaction.

6.10 Edit... Goto... [Ctrl+G]

Use this command to move the cursor to the beginning of the line specified in the 
Goto Line dialog. Type in the desired line number, which has to be at least 1 (first 
line). If the specified line number is bigger than the number of lines in the current 
document, the cursor jumps to the last line of the document.
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7 Program Control... Menu

7.1 Program Control... Execute

Use this command to switch to Execute mode. Programs that are loaded into the 
AS-i Master can be run by the AS-i Master now, the PC being only used to start 
and stop the program.
Stopping the AS-i Control program can be done by the command Stop or the com-
mand Pause. Stopping the AS-i Control program with the command Stop deletes 
the AS-i outputs, stopping it with Pause stops the program as well, but the outputs 
stay as they were set by the AS-i Control program.
While in Execute mode, you can display the Input Monitor, Output Monitor and 
Flag Monitor windows. In contrast to Debug mode, you can only change the dis-
played values in the flag monitor window. There is one exception: If the AS-i con-
trol program in the AS-i Master is currently stopped, you may also modify the 
output states.

7.2 Program Control... Debug

Use this command to switch to Debug mode. You can only switch to Debug mode 
if an AS-i Control mainfile is open. Switching to Debug mode causes a syntax 
check and compiles the program of the active window.
Programs that are loaded to the master can now be run by the PC. Data is trans-
ferred to the AS-i system so that the system reacts as if it is running independently. 
The program can be started, stopped and paused by ACT.
While ACT is in Debug mode you can use the Input Monitor, Output Monitor, 
Flag Monitor, Timer Monitor and Counter Monitor windows.

The Options and Setup sections of the active control program are 
ignored as long as you work in the Debug mode.
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7.3 Program Control... Simulate

Use this command to switch to Simulate mode. You can only switch to Simulate 
mode if an AS-i Control mainfile is open. Switching to Simulate mode causes a 
syntax check and compiles the program of the active window.
The AS-i Control programs now runs completely in the PC. In contrast to Debug 
mode, data is not transferred to the AS-i system. The whole AS-i system is simu-
lated by the PC instead. The program can be started, stopped and paused by ACT.
While AS-i Control Tools is in Simulate mode you can use the Input Monitor, 
Output Monitor, Flag Monitor, Timer Monitor and Counter Monitor windows.

7.4 Program Control... Read AS-Interface Control Mainfile from the 
AS-Interface Master...

Use this command to upload an AS-i Control program from the current AS-i Master 
into a new file window.
This command reads the AS-i Control program from the memory of the AS-i Mas-
ter and transfers it (in assembler code) to a new file window. The new file window 
is generated automatically and gets the name IL plus its own number.

7.5 Program Control... Write AS-Interface Control Mainfile to the 
AS-Interface Master...

Use this command to download the active AS-i Control program into the current 
AS-i Master.
This command is only available if an AS-i Control mainfile is open.
After downloading, select Start to begin program execution.

7.6 Program Control... Syntax Check

Use this command to check the syntax and consistence of the active AS-i Control 
program.

Make sure to adjust the desired desktop environment (e.g. monitor 
windows) before you run a program in Debug mode. If you access 
any menu or a window frame during the program run, a watchdog 
timeout may occur which stops the AS-i Control programs.

The Options and Setup sections of the active control program are 
ignored as long as you work in the Simulate mode.
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This command is only available if an AS-i Control mainfile is open. 

7.7 Program Control... Compile

In Debug and Simulate mode use this command to compile once again the AS-i 
Control program of the active file window.
This command is only available if an AS-i Control mainfile is open.

7.8 Program Control... Start

Use this command to start the AS-i Control program in the current AS-i Master. 

7.9 Program Control... Stop

Use this command to stop the AS-i Control program in the current AS-i Master or 
to stop the debugging or simulation of the AS-i Control program, depending on the 
previously selected mode of operation. This command sets the AS-i Control pro-
gram to its initial state, i.e. flags and outputs are deleted.

7.10 Program Control... Pause

In Execute mode this command stops the running AS-i Control program without 
deleting the outputs.

The syntax differs with the language (English/German). Only pro-
grams in the appropriate language will be recognized as valid pro-
grams.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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8 Master... Menu

8.1 Master... New...

Use this command to build up the communication with an AS-i Master connected 
to your PC.
The following pop up window appears:

In the drop down list you can select the select the corresponding protocol from the 
following range:

Stainless Steel AS-i/Profibus Gateway
Profibus: via mastersimulator or PG
Stainless Steel AS-i/Modbus Gateway
Stainless Steel AS-i/Ethernet Gateway
Ethernet Modbus TCP: via Ethernet
Allen Bradley AS-i Master/Scanner
AS-i Profibus GW+Safety Monitor
DeviceNet: AS-i 2.1 via mastersimulator
DeviceNet: AS-i 2.0 via mastersimulator
CANOpen: via mastersimulator
AS-i PCI board
AS-i PCI 2 board
AS-Interface PC2
Modbus: RS232 or via RS232/RS485 converter
Standard Protocol Bihl+Wiedemann
Stainless Steel AS-i/Ethernet IP Gateway

After you have selected the corresponding protocol and pressed OK, another pop 
up window appears. Here you can select the corresponing Serial port and insert a 
Bus address and Baud rate, if necessary. You can also define the corresponding 
AS-i circuit, if the AS-i Master supports this function.
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If there is already a communication to an AS-i Master use this command to change 
the communication parameters.
The communication parameters are stored for the next start of ACT. The software 
then tries to restore the connection to the most recently used AS-i Master.

8.2 Master... Identity...

Use this command to display identity and status information of the current master.
The AS-i master can also be controlled with this window. Beside the display of the 
most important AS-i Master flags, it is also possible to set some of these flags. The 
AS-i master can be switched between protected mode and configuration mode. 
Furthermore the AS-i Master can be set into the offline-phase. With this dialog you 
adjust the list of slave addresses that lead to a shut down of the AS-Interface in 
case of a config error.
If the AS-i Master is offline due to a config error, this dialog has to be selected to 
reset this list of slave adresses. After this reset the AS-i Master can exit the offline 
modus.  
The list of slave adresses that make sure that the AS-i Master goes offline will be 
deleted when the AS-i Master is disconnected. 

The Master... Identity... window is divided into the following areas:
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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AS-Interface Control
This button displays the AS-i Control properties dialog. This dialog displays the 
AS-i Control properties. These settings can only be changed in the AS-i Control 
program (see manual "AS-i Control"). This button is only available if the connected 
AS-i Master has the AS-i Control feature:

Start
The command "start program" was sent from the host to the AS-i Master.
Ignore configuration error
If this bit is set, errors can occur as the program continues to run as slaves fail with-
out appropriate measures being taken. If this bit is not set (factory default setting), 
the AS-i master stops the program when a configuration error on the AS-i circuit is 
detected.

Autostart
If this bit is set (factory default setting), the AS-i control program automatically 
starts up after powering on the AS-i master.
If this bit is not set, the ‘Set’ button on the front panel of the AS-i master must be 
pressed during power-up in order for the AS-i control program to start. The AS-i 
control program can of course also be started via software using the Start com-
mand in the Program control menu.

Map counters
If this bit is set, the contents of the first fifteen counters is mapped as a binary num-
ber to the marker bytes 96 to 125. This enables access to the counter contents so 
that you can determine when counters have reached a certain state.
If this bit is not set (factory default setting), the counter states are not mapped.

Input filter
Changes on the input data are only applied when the new input value has been 
stable for at least two AS-i cycles.

Synchronize AS-i Control program with AS-i cycle
Synchronizes the AS-i Control cycle with the AS-i cycle. (The AS-i Control cycle 
will increase to a minimum of 3 AS-i cycles.)
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Control program active
The AS-i Control program in the AS-i Master is running.

Cycle time
The current and the maximum cycle time of an AS-i Control program cycle are dis-
played here in milliseconds. If the maximum value is exceeded because of an error 
(e.g. an endless loop) a program cycle time-out will occur.

8.3 Master... AS-i Configuration

Use this command to start the AS-i configuration editor.
The command Grafical Display in the View menu changes the display style of the 
AS-i configuration editor between textual and grafical display.

8.3.1 Master... AS-i Configuration Editor (Textual Display)

This window displays the AS-i configuration (master and slaves) textually.

Master
This group displays information about the current AS-i Master:

24V Power failure
The AS-Interface master's power supply failed. The AS-Interface master is pow-
ered by the AS-Interface power supply.

Earth Fault
If one AS-i-line has a short circuit to earth, an Earth Fault exists. This error restricts 
significantly the noise immunity of the AS-i-communication.
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Periphery
• Periphery OK
This display is only available with an AS-i Master according to the AS-i specifica-
tion 2.1. and higher.

Bus-address
Master's bus-address, if available.

Status
possible values:
• Configuration OK
• Configuration error
• Not in normal operation
• Off-line
• AS-i power failure
• Store configuration
If you store the configuration you can correct configuration errors. More informa-
tion about the different status values you can find in following chapters.

Slaves
This group displays all currently detected slaves and the associated error status 
as follows:

Duplicate Address - 'a' 
If two slaves in one AS-i-Circuit have the same address, a Duplicate Address is 
present. It is an error, because both concerned Slaves can not be addressed sep-
arately by the master anymove.

Conflicting Types - 'c'
The profile of the detected AS-i slave does not match to the one specified for the 
projected AS-i slave.

Detected Only - 'd'
There is no AS-i slave projected for this address, although the displayed AS-i slave 
has been detected.

Projected Only - 'p'
There is no AS-i slave detected for this address, although one has been projected.

Peripheral Fault -  'f'
(only available with an AS-i Master according to the AS-i specification 2.1 and 
higher)
The AS-i slave with this address has a peripheral fault.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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The Type field contains the AS-i slave profile following the AS-i specification. To 
get more detailed information about the slaves, click on the Type field (next to the 
Address column) to open the Slave configuration dialog. A detailed description 
of the Slave configuration dialog you can find in the chapter Slave Context 
Menu (see page 31).

Show A/B-Slaves
Press this button to see the entries of the B-slaves resp. the A-slaves. This button 
is only available with an AS-i Master according to the AS-i specification 2.1 and 
higher.

8.3.2 Master... AS-i Configuration Editor (Grafical Display)

This window shows the AS-i configuration (master and slaves) grafically.
Use the command Grafical Display in the View menu to change the display style 
of the AS-i configuration editor between textual and grafical display (see also Con-
figuration Editor with textual display).
The right mouse button opens context menus which contain different commands, 
depending wether the mouse is positioned on the AS-i master or on an AS-i slave.
Double-clicking the AS-i master icon opens the Master Identity dialog, double-
clicking an AS-i slave icon opens the Slave configuration dialog.

8.3.2.1 Master Context Menu

Identity
Opens the Master Identity dialog.
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Store Configuration
This command stores the configuration data (IO, ID) of the AS-i slaves found on 
the AS-i line. This way configuration errors are fixed.
The configuration of the AS-i circuit is stored permanently in the AS-i Master.
Choose OK to continue and store the configuration into the AS-i Master.
Choose Cancel to leave the previous configuration unchanged.

Configuration

Opens the Master configuration dialog. This dialog makes possible the relation 
of a device description (including an icon) to the AS-i Master.

Device Description
Opens the Device description dialog. With this dialog device descriptions can be 
created. A detailed description of the Device Description dialog you can find in 
the chapter Slave Context Menu (see page 31).

Insert AS-i Slave
Opens the Slave configuration dialog with a free AS-i slave address.
To project an additional slave select the command Insert AS-i Slave in the Master 
context menu. The first free AS-i slave address will be used. Then select the profile 
of the slave to project.

8.3.2.2 Slave Context Menu

Configuration
Opens the Slave configuration dialog. The dialogbox Slave Configuration can 
contain (depending on the connected AS-i slave) the register tabs Address, Con-
figuration, Data and Parameter, as well as Analog Input and Analog Output.
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Slave Configuration... Address 

• Selected Slave
Address of currently selected slave.

• Change address to
To change the address of the selected slave, type in the desired address and ei-
ther use the RETURN key to close the dialog, or, if you want to continue, use the 
TAB key to change to another dialog element.
The valid address range is from 0 to 31 or if a slave with extended addressing is 
connected, from 0 to 31A and 0 to 31B.
Data exchange with a slave with address 0 is not possible.
It is not possible to change the address of an AS-i slave if there is another slave 
with address zero connected to the same AS-i line.

Note that all changes are performed as soon as you leave the edit-
box for example by pressing the TAB-key, and not only when you 
press the OK-button.
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Slave Configuration... Configuration

 

• Detected
Detected profile, hex-code and name.

• Projected
Projected profile, hex-code and name.
To change the projected profile, either type in the desired hex-code in the edit field, 
or select the desired profile in the drop down list.
To delete an AS-i slave from the configuration, type in the hex code FFFF in the 
edit field or choose the entry "none" in the drop down list beneath.

Profiles: Type in the profiles in the following format:
IO ID ID1 ID2
example: For IO=6, ID=A, ID1=C, ID2=3 type in: 6AC3.
If you have a standard slave (without 2.1 features), ID1 and ID2 each are "F".

• Store detected slave
Stores the current AS-i parameters as power-up parameters and the detected pro-
file as projected profile.

Note that all changes are performed as soon as you leave the edit-
box (for example by pressing the TAB-key), and not only when you 
press the OK-button.
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• Extended ID1
This editbox is only available when slave address 0 is selected. If a slave with ad-
dress 0 is connected to the AS-i line, you can change its extended ID code 1. This 
feature is only available with AS-i slaves and AS-i Masters according to the AS-i 
specification 2.1. and higher.

• Peripheral Fault
This checkbox displays if the AS-i slave has an error on its periphery. This feature 
is only available with AS-i slaves and AS-i Masters according to the AS-i specifi-
cation 2.1. and higher.

• Username
Type in an up to 30 characters long text, e.g. function or position of the AS-i slave 
in the plant.

• Device Type
This list serves to relate a device description (including an icon) to an AS-i slave.
If no slave is projected yet, you can select an AS-i slave from this product list. This 
action then also projects the matching configuration codes.
Device descriptions can be created with the Device description dialog.
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Slave Configuration... Data and Parameter 

• Inputs
Current input bits, if available.

• Outputs
Current output bits, if available.

• Current Parameters
Current parameter bits.

• Power-up Parameters
Power-up parameter bits.

Dialog Slave Configuration... Analog Input
This dialog shows the analog input data of 1 to 4 channels (depending on the 
slave). The data is displayed hexadecimal, decimal and grafically as a progress 
bar. This dialog is only available if an analog input slave is connected.
The scale of the progress bar can be adjusted by entering a minimum and a max-
imum value. These values can be typed in as decimal numbers and also as hexa-
decimal numbers by preceding a "0x".

All actions in this dialog are performed "on-line", that means directly 
in the AS-i circuit. If, for instance, you click on an output bit, the out-
put of the AS-i slave will be toggled immediately.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Slave Configuration... Analog Output 

The changes of the edit boxes are executed as soon as you press the Apply or 
the OK button.
This dialog shows the analog output data of 1 to 4 channels (depending on the 
slave). The data can be entered hexadecimal, decimal or by dragging the slider. 
This dialog is only available if an analog output slave is connected.
The scale of the sliders can be adjusted by entering a minimum and a maximum 
value. These values can be typed in as decimal numbers and also as hexadecimal 
numbers by preceding a "0x".

Slave Configuration... String Transfer
This dialog servers to transfer ID-string, diagnostic string and parameter string of 
7.4 slaves.
These strings are displayed as hex-bytes, separated with spaces, 
e.g.: 01 23 45 67 89 AB CD EF...

Note that all changes of the sliders are performed immediately.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Device Description...

This dialog makes possible to create a list of device descriptions (device list). A 
complete device description contains of:

Icon, Device Name and Manufacturer

Enter this information in the appropriate edit boxes. The icon can be selected from 
the icon library (slaves.icl). If there are other icon libraries (*.icl) at your disposal, 
just copy these to the working directory of the software.

Choose the device type
AS-i Slave: enter IO and ID or select type from list. The check box Master shall not 
be selected.
AS-i Master: click the check box Master.

Plug-In-Name
If there are plug-ins available you can select one and associate it with the device. 
The additional plug-in page will appear if this device description is selected in the 
Slave Configuration dialog and an appropriate slave is connected to the AS-i cir-
cuit.

Add
This button relates the device description to the device type and adds it to the de-
vice list.

Remove
This button removes the selected entry of the device list.

Apply
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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This button applies the changes and updates the device list without closing the di-
alog box.
Now you can select the right description (including the icon) in the Slave Config-
uration dialog with the device type item.
The same procedure can be done for the AS-i Master with the command Config-
uration in the Master context menu.

8.3.2.3 Display of Configuration Errors
Depending on the current configuration of the AS-i Master and the detected slaves 
on the AS-interface the icons obtain an appropriate mark:

Conflicting Types (yellow exclamation mark)
 The profile of the detected AS-i slave does not match to the one specified 
for the projected AS-i slave.

Detected Only (green exclamation mark)
 There is no AS-i slave projected for this address, although the displayed 
AS-i slave has been detected.

Peripheral Fault (red exclamation mark)
This AS-i slave has a peripheral fault.

Projected Only (red shade)
 There is no AS-i slave detected for this address, although one has been 
projected.

To get more detailed information about the slaves, choose the command Config-
uration in the Slave context menu. If you double click the slave icon with the left 
mouse button the dialogbox opens as well.

Duplicate Address (red exclamation mark)
If two slaves in one AS-i-Circuit have the same address, a Duplicate Ad-
dress is present. It is an error, because both concerned Slaves can not be 
addressed separately by the master anymove. 

Earth Fault (red exclamation mark)
If one AS-i-line has a short circuit to earth, an Earth Fault exists. This error 
restricts significantly the noise immunity of the AS-i-communication.

24V Power failure (red exclamation mark)
The AS-Interface master's power supply failed. The AS-Interface master 
is powered by the AS-Interface power supply.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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8.4 Master... AS-i Diagnosis...

List of Corrupted Slaves (LCS)
The AS-interface is a system with outstanding noise immunity. Sometimes, how-
ever, momentary configuration errors may occur because of external influences. 
The advanced AS-i diagnosis helps to find and locate the causes for these mo-
mentary configuration errors.
The AS-i masters with advanced diagnosis manage beside the list of projected 
slaves (LPS), the list of detected slaves (LDS) and the list of activated slaves 
(LAS) a forth list, the List of Corrupted Slaves (LCS). This LCS contains entries of 
all AS-i slaves which were responsible for at least one configuration error since 
powering up the AS-i master or since the last reading of the list. Momentary AS-i 
power failures are displayed in the LCS at the position of AS-i slave with address 
0, which is marked as APF.
The LCS is read via the host interface - ISAbus for AS-i PC boards, serial interface 
or the respective fieldbus interface (PROFIBUS, INTERBUS, Modbus Plus etc.). 
Every read access deletes the LCS.
Reading the LCS enables the user to find out quickly, which AS-i slaves have 
caused configuration errors on the AS-interface, even if they happened only occa-
sionally.

Red Point
A red point (!) behind the slave address indicates that one or more errors have 
been caused by this slave since the last read cycle.

Black Point
A black point (!) behind the slave address indicates that one or more erros has 
been caused by this slave since the AS-i Master is powered or since the last reset 
of the LCS.

Reset
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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This button deletes the LCS.

Protocol Analysis AS-Interface: Counters of Telegram Repetitions
Although AS-interface has data and power on the same cable, the system pro-
vides a high data integrity, because of in-built error checking. This high data integ-
rity is reached now and then because corrupted telegrams are sent again. The 
AS-i master only releases a configuration error, when an AS-i slave has not sent 
a valid telegram within 6 master calls. This means as long as one of the first 6 slave 
telegrams is valid there won't be a configuration error on AS-i. So it can happen, 
that the AS-interface appears to work fine, but in reality the data transmission on 
the AS-i cable is corrupted, but not corrupted enough to release configuration er-
rors.
For this reason the advanced diagnosis has a counter of telegram repetitions for 
each AS-i slave, which is increased everytime there is a corrupted data telegram. 
This makes possible to judge the quality of the AS-i network, even if only a few cor-
rupted telegrams occured and the AS-i slave did not cause any configuration er-
rors.

Current
The number of errors since the last read cycle is displayed in the "Current" column 
red color. This entry will be overwritten by the next read cycle (approx. every 2 s).

Accum.
The total number of errors since the AS-i Master is powerded or since the last reset 
of the error counters is displayed.

Reset
This button deletes all counters.
The counter values are read via the host interface and will be deleted with every 
read access. The counter value is limited to 254. 255 means counter overflow.
The Error Counter enables the user to judge directly about the quality of the AS-i 
networks data transmission. For example AS-i slaves can be detected, which send 
frequently corrupted telegrams because of EMC disturbances, although on the 
AS-interface no configuration error occured.

Show A/B-Slaves
Press this button to see the entries of the B-slaves resp. the A-slaves. This button 
is only available with an AS-i Master according to the AS-i specification 2.1 and 
higher.

Please note that a small number of corrupted telegrams over a 
longer period of time is normal and is no reason to get alarmed.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Deblock AS-i Diagnosis...
After installing the software the advanced AS-i diagnosis is blocked.
This dialog deblocks the AS-i diagnosis either for the current work session or per-
manently.
Please contact the software manufacturer to get the appropriate code.

8.5 Master... AS-i Fault Detector

The AS-i Fault Detector permanently tests the system for the following dysfunc-
tions/annoyances:

Duplicate Address
If two slaves in one AS-i-Circuit have the same address, a Duplicate Address is 
present. It is an error, because both concerned Slaves can not be addressed sep-
arately by the master anymove. Furthermore the master can not distinguish the re-
sponses of the Slaves, because their responses overlap. The behaviour of the 
system is extremely unstable.

Duplicate addresses can only be detected in the AS-i segment of the 
master. If both slaves that are involved in the duplicate address are 
mounted behind a repeater, dublicate address can not be detected.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Earth Fault
If one AS-i-line has a short circuit to earth, an Earth Fault exists. This error restricts 
significantly the noise immunity of the AS-i-communication.

Over Voltage
Over voltage means, that the electrical potential of the AS-i lines which is normally 
symmetrically to earth, is strongly shifted. Reason can be switching of strong con-
sumers. Over voltage is normally not disturbing the AS-i communication but sen-
sors may give faulty signals. 

Noise
Recognition of the interference noise detects the AC voltages on AS-i, which are 
produces not by the AS-i-master or AS-i-slaves. These interference voltages can 
cause the telegram faults. 
Frequent reasons are not sufficiently schielded frequency converters or misplaced 
AS-i cable.

The column

Actual
shows the actual condition of the system

Historic
shows errors that occured since the AS-i-masters was turned on respectively since 
the latest Reset.

Reset
clicking the Reset button removes the data about Historic.

For recognition of earth faults the master must be grounded to the 
function earth.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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8.6 Master... AS-i Safety

The AS-i Safety Monitor shows the state of each AS-i Safety slave connected to 
the AS-i circuit. Possible states are "OK" and "Released".

AS-i Safety Monitor
This button opens another dialog box that shows the diagnosis of the AS-i Safety 
Monitor:

Monitor Address
Type in the AS-i address of the AS-i Safety Monitor so that the diagnosis can be 
read.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Read Diagnosis
Executes the command to read the AS-i Safety diagnosis in the AS-i Master. If this 
function fails (e.g. because the address of the AS-i Safety Monitor is wrong), the 
following fields remain empty.

• Monitor-Diagnosis 
provides the actual state of the Safety-Monitor

• Last Diagnosis 
provides the state of channel and the device colors at the time the relays of chan-
nel were switched off

OSSD
Channel number of output device

Diagnosis index
When reading the diagnosis you receive only devices that have been asigned a 
diagnosis index. The diagnosis index defines the sorting succession of displaying.

Sorted
If the monitor is switched to sorted mode, select this check box.

AS-i Safety Monitor
Contains the diagnosis data of the AS-i Safety Monitor.

Channel 1
Contains the diagnosis data of Channel 1 of the AS-i Safety Monitor.

Channel 2
Contains the diagnosis data of Channel 2 of the AS-i Safety Monitor.

Close
Closes the dialog box.

Significance of the colours in the Monitor-Diagnosis view
• green 
Device is in the ON state (switched on)
• green flashing
Device is in the ON state (switched on), but already in the process of being 
switched to the OFF state, e.g. switch-off delay
• yellow
Device is ready, but is still waiting for another condition, e.g. local acknowledge-
ment or start button
• yellow flashing
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany

Pepperl+Fuchs Group · Tel.: Germany (6 21) 7 76-0 · USA (3 30) 4 25 35 55 · Singapore 7 79 90 91 · Internet http://www.pepperl-fuchs.com44



   

AS-Interface Control Tools
Master... Menu
Is
su

e 
da

te
 - 

28
.7

.2
00

8

Time condition exceeded, action must be repeated, e.g. synchronisation time ex-
ceeded
• red
Device is in the OFF state (switched off)
• red flashing
The error lock is active, release by means of one of the following actions:
• Acknowledge with the service button 
• Power OFF/ON 
• AS-interface bus OFF/ON
• grey                
No use of OSSD / no communication with the AS-interface slave

8.7 Master...Stainless Steel AS-i Safety Monitor

Contains the diagnosis data of the Stainless Steel AS-i Safety Monitor.

Internal
The internal AS-i Safety-Monitor.

External
The external AS-i Safety-Monitor.

Monitor address
Before reading the diagnosis, you have to choose the address of the external AS-
i Safety-Monitor.

Diagnosis

• Monitor-Diagnosis
Provides the actual state of the Safety-Monitor.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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• Last Diagnosis 
Provides the state of channel and the device colors at the time the relays of chan-
nel were switched off.

OSSD
Channel number of output device.

Complete
When reading the diagnosis you receive all used devices.

Diagnosis index
When reading the diagnosis you receive only devices that have been asigned a 
diagnosis index. The diagnosis index defines the order in the display. 
Selecting check box 0.. (default setting) will return ALL devices starting with 0 and 
upwards.
Selecting check box 32.. will return ALL devices according to the device index in 
the ASI-Monitor software starting with 32 and upwards.

Read
Updates the AS-i Safety diagnosis.

Auto Update ( 5 s )
Automatically updates the AS-i Safety diagnosis every five seconds.

AS-i Slave Address (Info)
Automatically reads the slave address info of all subdevices. Doubleclick on a de-
vice to get more information of the device.

Device / Slave
Device index and if applicable the address of the correspondent safety slave. 
Apears if Complete check box is selected.

Index / Slave
Diagnosis index and if applicable the address of the correspondent safety slave. 
Apears if Diagnosis index check box is selected.

Device from
Indicates the allocation of therespective device. Possible allocations are:
• Preprocessing
• Both circuits
• Circuit 1
• Circuit 2
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Significance of the colours in the Monitor-Diagnosis view.
For information about the significance of the colours in the Monitor-Diagnosis view 
see page 44. For a graphic example see page 45. 

8.8 Master... AS-Interface Address Assistant

The AS-Interface Address Assistant serves to ease the configuration of an AS-i 
network. With the use of the AS-Interface Address Assistant an AS-i network can 
be configured without the help of any additional tools like a handheld addressing 
device.
1. Load the previously created AS-i Configuration file (*.acg) that includes all pro-

jected slaves, into the AS-i Master (command Write Configuration to the AS-i
Master in the Master menu, Seite 48).

2. Start AS-Interface Address Assistant.
3. Now connect all new AS-i slaves (address 0) in turn (ascending addresses) to

the AS-i line.
The next AS-i slave that has to be connected to the AS-i line is displayed in a dif-
ferent color.
The AS-Interface Address Assistant automatically changes the address of the 
connected slave from 0 to the assigned address. If the slave profile of the connect-
ed slave is different from the projected slave profile the address won’t be changed.
AS-i configuration errors are displayed in the AS-Interface Address Assistant in the 
same way as the AS-i Configuration editor does.

8.9 Master... Insert AS-Interface Slave

Use this command to project an AS-i slave on a free AS-i slave address.
The Slave Configuration dialog (see page 33) will be opened. With this dialog the 
desired projection can be done.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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To delete an AS-i slave from the configuration, type in the hex code FFFF in the 
Projected edit field of the Slave Configuration dialog or choose the entry (none) 
in the drop down list beneath.

8.10 Master... Write Configuration to the AS-Interface Master...

This command loads an AS-i configuration from a file into the AS-i configuration 
editor and writes it to the currently connected AS-i Master. The default file exten-
sion for AS-i configuration files is *.acg.
This command is just available if the configuration editor is open and active and 
can only be used, if the host interface (Profibus, Modbus, Ethernet etc) is inactive.

8.11 Master... Save Configuration to File...

This command is used to save the currently in the AS-i configuration editor dis-
played AS-i configuration to a file. The default file extension for AS-i configuration 
files is *.acg.
This command is only available if the configuration editor is open and active.

8.12 Master... 0 Offline

This command changes to the offline mode. In this mode the software communi-
cates with a "virtual AS-i Master".
This mode serves to create an AS-i configuration without the need of a real AS-i 
Master connected to the PC.

8.13 Master... 1 [Most recently used Master]

This command changes the active communication to the most recently used AS-i 
Master, if available.
The menu entry gives a short description of the settings of the most recently used 
AS-i Master:

AS-i Masters with serial interface:
protocol, COM-port and bus-address (if available)

AS-i Masters as PC-boards:
protocol and bus-address
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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9 View... Menu

9.1 View... Toolbar

Use this command to display or hide the toolbar, which includes buttons for some 
of the most common commands of AS-i Control Tools, such as File Open. A tick 
appears next to the menu item when the toolbar is displayed.

The Toolbar
 

Click to... to...

 Tool- Menu-
 bar command Description

File...

New open a new file.

Open open an existing file.

Safe save the active file under its current name.

Print print the active file.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Edit...

Cut remove selected data and store it in the clip-
board.

Copy copy selected data to the clipboard.

Paste insert the contents of the clipboard at the 
cursor location.

Master...

Identity show the Master identity dialog.

AS-i Configuration show the AS-i Configuration editor.

View...

Graphical Display enable or disable the graphical display of the 
AS-i Configuration editor.

(no menu)

Context Help show help for items that you select with the 
mouse pointer. 

9.2 View... Statusbar

Use this command to display or hide the Status Bar, which describes the action to 
be executed by the selected menu item or depressed toolbar button, keyboard 
latch state and displays other information. A tick appears next to the menu item 
when the statusbar is displayed.
Statusbar

 

Area: A B C D E F  G
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Actions and messages (area A)
Area A of the statusbar describes the action of the menu entries, when you select 
the items with the arrow keys or the mouse. This area also shows messages de-
scribing the actions of toolbar buttons as long as you keep them pressed. If you do 
not wish to execute the command, release the mouse button only when you have 
moved the mouse pointer away from the toolbar button.

Modes and States (area B)
Area B displays the current mode of operation and state of the AS-i Control pro-
gram. The following modes of operation are possible: Execute, Debug, Simula-
tion. The following states can occur: The AS-i Control program runs, is stopped 
or is paused.

Keyboard States (area C, D, E)
• OVR
The Overwrite key is latched down.
• CAP
The Caps Lock key is latched down.
• NUM
The Number Lock key is latched down.

Line Number (area F)
If the active window is an editor window, area F shows the line number, where the 
cursor is currently located.

Communication Indicator (area G)
In the rightmost corner there is an indicator for the data transmission to the AS-i 
Master. While communicating with the AS-i Master, the communication indicator 
keeps changing between displaying "| / - \" to produce a rotary visual effect.
If the connection to the AS-i Master breaks down, this rotation stops immediately. 
It is replaced by a red question mark (?) if the connection can not be reestablished.

9.3 View... Font...

Use this command to select the font for the current document window.
The following options allow you to specify the typeface, style and size of the font 
for use in the current document window:

Typeface
Select the typeface you want to use in the current document window.

Style
Select the style you want to use in the current document window.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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Size
Select the size you want to use in the current document window.

Sample
This window is read-only and gives you an example of the current selection.
You can only change the font of an editor window.

9.4 View... Grafical Display

Use this command to select the display style of the AS-i configuration editor.
Is this menu item checked the AS-i configuration editor is displayed grafically, oth-
erwise it is displayed textually.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany
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10 Window...Menu

10.1 Window... New Window

Use this command to open a new window with the same contents as the active 
window. You can open several document windows to display different parts or 
views of a document at the same time. 
If you change the contents in one window, all other windows containing the same 
document reflect the changes. When you open a new window, it becomes the ac-
tive window and is displayed on top of all other open windows.

10.2 Window... Cascade

Use this command to arrange open windows so that they overlap. The windows 
overlap one another and in general only the active window on top will be fully dis-
played.

10.3 Window... Tile

Use this command to arrange the opened windows side by side.

10.4 Window... Arrange Icons

Use this command to arrange the icons for minimized windows at the bottom of the 
main window. If there is an open document window at the bottom of the main win-
dow, then some or all of the icons may not be visible because they are underneath 
this document window.

10.5 Window...AS-i Configuration

Use this command to start the AS-i Configuration editor. For detailed description 
see page 28.
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany

Pepperl+Fuchs Group · Tel.: Germany (6 21) 7 76-0 · USA (3 30) 4 25 35 55 · Singapore 7 79 90 91 · Internet http://www.pepperl-fuchs.com 53



  

AS-Interface
Window...Menu
Is
su

e 
da

te
 - 

28
.7

.2
00

8

10.6 Monitor Windows

The monitor windows serve to control and modify AS-i data. The following monitor 
windows are available:
• Input monitor
• Output monitor
• Flag monitor
• Timer monitor
• Counter monitor

In Execute mode, you can open the input monitor, output monitor and flag 
monitor windows. Only in the flag monitor window modifying the bits is possible 
while the AS-i Control program is running. If the AS-i control program in the AS-i 
Master is currently stopped, you may also modify the output states.
In Debug and Simulate mode in all monitor windows data can be modified. How-
ever, data can be overwritten again by the results of the AS-i Control program.

Modifying Bits
To modify the bits, click on the appropriate bit position.

Modifying Values
Use the mouse to let a small box pop up for the 'Value' field, type in the desired 
value and press ENTER to close the box.
Inputs and outputs get a single-digit hexadecimal value, flag bytes are represented 
as double figures hexadecimal values.
The values for timers and counters have to be entered as decimal values and have 
a range from 0s to 40.95s for the timers and from 0 to 65535 for the counters.

10.6.1 Window... Input Monitor
Subject to reasonable modifications due to technical advances. Copyright Pepperl+Fuchs, Printed in Germany

Pepperl+Fuchs Group · Tel.: Germany (6 21) 7 76-0 · USA (3 30) 4 25 35 55 · Singapore 7 79 90 91 · Internet http://www.pepperl-fuchs.com54



   

AS-Interface Control Tools
Window...Menu
Is
su

e 
da

te
 - 

28
.7

.2
00

8

This window shows the inputs of the AS-i slaves.
You can modify the input only in Debug and Simulate mode.

User
The User field indicates whether this address is currently under user control or not. 
In the former case the bit mask is operated by the user, while in the latter case it 
is operated by the AS-i Control program.

Modifying Bits
To modify the bits, you can either click on the appropriate bit position or use the 
mouse to let a small box pop up to enter the desired bit mask as a single digit val-
ue. The value has to be in the hexadecimal range (0-9 and A-F).

10.6.2 Window... Output Monitor
This window shows the outputs of the AS-i slaves.
You can modify the outputs only in Debug and Simulate mode.

User
The User field indicates whether this address is currently under user control or not. 
In the former case the bit mask is operated by the user, while in the latter case it 
is operated by the AS-i Control program.

Modifying Bits
To modify the bits, you can either click on the appropriate bit position or use the 
mouse to let a small box pop up to enter the desired bit mask as a single digit val-
ue. The value has to be in the hexadecimal range (0-9 and A-F).

In debug mode the outputs are set directly on the AS-i circuit. If you 
click on an output bit the output of the AS-i slave will toggle immedi-
ately.
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10.6.3 Window... Flag Monitor

This window shows the flags of the AS-i Control program. You can modify the flags 
in all modes of operation.

User
The User field indicates whether this address is currently under user control or not. 
In the former case the bit mask is operated by the user, while in the latter case it 
is operated by the AS-i Control program.

Modifying Bits
To modify the bits, you can either click on the appropriate bit position or use the 
mouse to let a small box pop up to enter the desired bit mask as a single digit val-
ue. The value has to be in the hexadecimal range (0-9 and A-F).

10.6.4 Window... Timer Monitor
This window is only available in Debug and Simulate mode and shows the timers 
of the AS-i Control program.

Modifying Values
Use the mouse to let a small box pop up for the 'Value' field and type in the desired 
value between 0s and 40.95s.

10.6.5 Window... Counter Monitor
This window is only available in Debug and Simulate mode and shows the 
counters of the AS-i Control program.
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Modifying Values
Use the mouse to let a small box pop up for the 'Value' field and type in the desired 
value between 0 and 65535.

10.6.6 Window... Analog Input Monitor
This window shows the hexadecimal input values of the analog AS-i slaves.

10.7 Window... Output Log

This window shows a list of recent errors while operating the AS-i system with the 
AS-i Control Tools. The entries of the list are numbered and state the time when 
the error occured.

10.8 Window... 1, 2, ....

At the bottom of the Window menu a list of currently open document windows is 
displayed. A tick appears in front of the document name of the active window. 
Choose a document from this list to make its window active.
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11 Help...Menu

11.1 Help... Index

Use this command to display the opening screen of Help. From the opening 
screen, you can jump to step-by-step instructions for using the application.
Once you open Help, you can click the Contents button whenever you want to re-
turn to the opening screen.
 Click the Back button to return to the last help topic you looked at. 
The Search button allows you to get information to a specific subject by typing in 
a keyword.
With the Print button you can print the corresponding help page.
Use the Annotation button to take notes to an help page and store them at the 
correspondig page. A stored note is displayed with a paper clip Symbol in the up-
per left corner of the page. Clicking the symbol opens the Annotation window 
where you can edit or delete the note. 
Close the Help window with the Exit button.
With the buttons << respectively >> you get to the recent / next help page.

11.2 Help... Using Help

Use this command for instructions about using help.
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11.3 Help... Registration

After the installation the software is not licensed yet.
This dialog enables you to license the basic software and also to deblock the 
AS-i Control functionality (programs larger than 600 bytes) and the advanced 
AS-i diagnosis by entering the corresponding codes.
Type in your first name, your last name and the company name and also the code 
for the basic version of the software.
If your software CD does not include the registration codes, please contact the 
software producer to ask for the adequate codes.

11.4 Help... Info...

Use this command to display information about the installed version of the appli-
cation (version number, copyright note and your personal registration data).

11.5 Context Help

Use the Context Help command to quickly obtain help on most aspects of ACT.
When you press the Context Help button of the toolbar, the mouse pointer chang-
es to an arrow and question mark. Then click somewhere, such as another toolbar 
button to obtain help for the selected item.
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